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SCXI1"-1383 Power Supply/Float Charger
Installation Guide

This guide describes how to install and use the SCXI-1383 power
supply/float charger.

The SCXI-1383 is a 13.8 VDC, 4 A power supply/float charger, which
requires an input of 100 to 240 VAC, 50/60 Hz.

You can use the SCXI-1383 to perform the following three tasks:
»  powering the SCXI-1000DC chassis directly

» charging the SCXI-1382 battery pack

» float-charging the SCXI-1382 battery pack while powering the
SCXI-1000DC chassis, which provides uninterruptable power for
the SCXI-1000DC chassis

Each of these tasks are detailed in this document.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

> &

bold Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

National Instruments™, NI™, ni.com™, and SCXI™ are trademarks of National Instruments Corporation. Product and April 2003
company names mentioned herein are trademarks or trade names of their respective companies. For patents covering 371190A-01
National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents. txt file

onyour CD, orni.com/patents.

y NATIONAL

© 1994-2003 National Instruments Corp. Al rights reserved. INSTRUMENTS



italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

What You Need to Get Started

To set up and use the SCXI-1383, you need the following:

U SCXI-1383 power supply/float charger
Q  SCXI-1383 Power Supply/Float Charger Installation Guide
Q  Read Me First: Safety and Radio-Frequency Interference
U One of the following power cords, depending on the power
requirements of your geographical region:
—  United States/Japan power cord
—  Switzerland power cord
— Australia power cord
—  Universal Euro power cord

—  North America power cord

—  United Kingdom power cord

In addition to the SCXI-1383 kit contents, you need an SCXI-1000DC
chassis and/or an SCXI-1382 battery pack.

@ Note If your kit is missing any of its components, contact NI. You can download any
NI document from ni.com/manuals.
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Connecting the SCXI-1383 to the SCXI-1000DC Chassis
in Power Supply Mode

E Note Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting or disconnecting any power wires or
signal wires.

A Caution Always power off the SCXI-1000DC and the SCXI-1383 before you connect or
disconnect them from each other.

To connect the SCXI-1383 power supply/float charger to the
SCXI-1000DC, refer to Figure 1 and complete the following steps:

1. Power off the SCXI-1000DC chassis by using the power switch on the
SCXI-1000DC front panel.

2. Connect the green DC power connector (P2) of the SCXI-1383 power
supply/float charger to its corresponding connector (J1) on the rear
panel of the SCXI-1000DC chassis.

3. Connect the IEC 320-style connector of the power cord to its connector
on the power supply/float charger.

4. Connect the AC power plug of the power cord to a 100 to 240 VAC,
50/60 Hz power source.

5. Power on the SCXI-1000DC chassis using the power switch on the
chassis front panel.

The green LED on top of the SCXI-1383, when used to power the
SCXI-1000DC chassis directly, has the following characteristics:
» the green LED is off, which could mean
— the SCXI-1000DC power switch is set to the O (off) position
— there is no VAC power to the SCXI-1383
— the SCXI-1383 output is disconnected
—  the SCXI-1000DC fuse is bad
* the green LED is bright

—  the SCXI-1000DC power switch is set to the I (on) position and
the SCXI-1383 is properly connected

» the green LED blinks rapidly
— the SCXI-1383 may need servicing

E Note Refer to the label on the SCXI-1383 for more LED status information.
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f Caution Always replace a bad fuse with a fuse of the same size and rating for continued

fire protection.

1 SCXI-1000DC Chassis 4 To VAC Power Source
2 A 5 P2
3 SCXI-1383 Power Supply/Float Charger

Figure 1. Connecting the SCXI-1383 to the SCXI-1000DC Chassis
in Power Supply Mode

Charging the SCXI-1382 Battery Pack with the
SCXI-1383

Caution Always unplug the SCXI-1383 before you connect or disconnect it from the
SCXI-1382.

To charge the SCXI-1382 battery pack with the SCXI-1383 charger, refer
to Figure 2 and complete the following steps:

1. Connect the green DC power connector (P2) of the SCXI-1383 power
supply/float charger to its corresponding connector (J2) on the rear of
the SCXI-1382 battery pack.

2. Connect the IEC 320-style connector of the power cord to the
connector on the SCXI-1383.

3. Connect the AC power plug of the power cord to a 100 to 240V,
50/60 Hz power source.

@ Note The SCXI-1383 charger takes approximately 12 to 14 hours to fully charge the
SCXI-1382 battery pack.
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Charge the battery pack as soon as possible after use. If the battery is fully
charged, it can power the SCXI-1000DC chassis for more than five hours.
However, we recommend that you charge the battery after every three hours
of use to extend the life of the battery pack.

A Caution The battery pack contains a sealed lead-acid battery that contains toxic material
(lead) and corrosive fluid (sulfuric acid). Charging can produce explosive gases. Do not
charge the battery in gas-tight enclosures. Charge the battery in a well ventilated area away
from sparks, flames, or smoke. Do not short the battery pack terminals, as this can cause
an explosion or fire. Do not store the battery pack in a discharged state. Do not puncture,
disassemble, mutilate, or incinerate the battery pack. Recycle the battery or dispose of the
battery pack with automotive battery scrap. The battery charger dissipates heat. Use the
charger in an area with ample air circulation.

The green LED on top of the SCXI-1383, when used to charge the
SCXI-1382, has the following characteristics:

» the green LED is off, which could mean
—  the SCXI-1382 battery pack is fully charged
— there is no VAC power to the SCXI-1383
—  the SCXI-1383 output is disconnected
— the SCXI-1382 fuse is bad
* the green LED is bright
—  the SCXI-1382 is charging
*  the green LED is dim
— the SCXI-1382 is near to a full charge
» the green LED is flashing
—  the SCXI-1382 is fully charged
* the green LED blinks rapidly
—  the SCXI-1382 or SCXI-1383 may need servicing

@ Note Refer to the label on the SCXI-1383 for more LED status information.

Caution Always replace a bad fuse with a fuse of the same size and rating for continued
fire protection.
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1 J2

3 P2

2 SCXI-1382 Battery Pack

4 SCXI-1383 Power Supply/Float Charger
5 To VAC Power Source

Figure 2. Charging the SCXI-1382 Battery Pack with the SCXI-1383 Charger

Connecting the SCXI-1383 to the SCXI-1000DC Chassis
and the SCXI-1382 Battery Pack in Float-Charging Mode

JAN

Caution Always power off the SCXI-1000DC and unplug the SCXI-1383 before you
connect or disconnect them from each other or the SCXI-1382.

To connect the SCXI-1383 power supply/float charger to the
SCXI-1000DC and the SCXI-1382 battery pack in float-charging mode,
refer to Figure 3 and complete the following steps:

1.

Fully charge the battery, as described in the Charging the SCXI-1382
Battery Pack with the SCXI-1383 section, before connecting the
SCXI-1383 to the SCXI-1382 battery pack in float mode.

Power off the SCXI-1000DC chassis using the power switch on the
SCXI-1000DC front panel.

Connect the green DC power connector (P1) on the SCXI-1382 battery
pack to its corresponding connector (J1) on the rear panel of the
SCXI-1000DC chassis.

Connect the green DC power connector (P2) of the SCXI-1383 power
supply/float charger to its corresponding connector (J2) on the rear
panel of the SCXI-1382 battery pack.
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Connect the IEC 320-style connector of the power cord to its connector
on the SCXI-1383 power supply/float charger.

Connect the AC power plug of the power cord to a 100/240 VAC,
50/60 Hz power source.

The SCXI-1383 power supply/float charger is now powered on and is
float charging the SCXI-1382 battery pack. Power on the
SCXI-1000DC chassis using the power switch on the chassis front
panel.

@ Note While in float-charging mode, the green LED on the top of the SCXI-1383 case
illuminates only if the battery is not fully charged.

The green LED on top of the SCXI-1383, when used to float-charge the
SCXI-1382, has the following characteristics:

the green LED is off, which could mean

—  the SCXI-1382 battery pack is fully charged
— there is no VAC power to the SCXI-1383

— the SCXI-1383 output is disconnected

— the SCXI-1382 fuse is bad

the green LED is bright

— the SCXI-1382 is charging

the green LED is dim

— the SCXI-1382 is near to a full charge

the green LED is flashing

—  the SCXI-1382 is fully charged

the green LED blinks rapidly

— the SCXI-1382 or SCXI-1383 may need servicing

E Note Refer to the label on the SCXI-1383 for more LED status information.

Caution Always replace a bad fuse with a fuse of the same size and rating for continued

fire protection.
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1 SCXI-1000DC Chassis 5 SCXI-1383 Power Supply/Float Charger
2 J1 6 To VAC Power Source
3 J2 7 P2
4 SCXI-1382 Battery Pack 8 P1
Figure 3. Connecting the SCXI-1383 Power Supply/Float Charger to the SCXI-1000DC
Chassis and the SCXI-1382 Battery Pack in the Float-Charging Mode
Specifications
Input
Input voltage ........coceeveveeieniniencnicnens 100 to 240 VAC (universal input)
Input frequency.......ccoceeeeeeneniencnnicneens 50/60 Hz
Input current ........ccccoceeeeeieninienenienee 2Aat115 VACor
1 A at 230 VAC (max)
Inrush current........cccoeceeeeeervenieeneeennenns <30 Aat 115 VAC or
60 A at 230 VAC input
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Output

Output VOItage......ccccevvevveenieneenenieiennees

Charging current .........c..ccceeeevenennenene

General Features
Efficiency ......cooevveveevenieninenceiecn

Protections......ccceeeeveeeuveeeeeieiieeeeeeenenen.

Physical

DIimensions.........ceeevveeeeeieeiieiiiiiieieieennns

Connectors
AC INICT e

DC output......coueeveeieiiiicieneeceeeeeneen

INdicator ......cooovveeieiiiiieee e

Between 13.8 and 13.95V
(at 200 mA load);
<14.1 V at no load

Between 3.7 to 4.5 A when
battery voltage is lower than 13.6
to 13.8 V; limited by Ohm’s law
when battery voltage is higher
than 13.6to 13.8 V

>75% at nominal line
and 3.7 A output

2 A, 250 V ceramic input fuse;
reverse polarity protection
performed by auto-recovery
circuit; the unit protects itself in
case of short circuit or if the
battery voltage is below 5to 7V

16.5by 8.0 by 5.7 cm
(6.5by 3.2by2.21in.)

IEC 320/CEE 22 standard

Phoenix Contact Combicon
connector with UL 1015,

16 AWG CSA, TEW 105 °C,
600 V wires

Refer to the SCXI-1383 label
for complete LED status
information!

' Also refer to the section in this document that details the mode of operation you are using.
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Environmental

Operating temperature ..........c..coceeeeneenne 0to 50 °C
Storage temperature.............ceceeeeeuenees —20t0 70 °C
Humidity ....oooooveeniniiniiiiniicienee 10 to 90% RH, noncondensing
Maximum altitude...........oooeevvvvvivviennnnns 2,000 meters
Pollution Degree (indoor use only) ........ 2
Safety

The SCXI-1383 is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:
 IEC61010-1, EN 61010-1
« UL3111-1, UL 61010B-1
« CAN/CSA C22.2 No. 1010.1

@ Note For UL and other safety certifications, refer to the product label or to ni . com.

Electromagnetic Compatibility

EmiSSIONS...cvvvviiiieiiiieeeeeciieee e EN 55011 Class A at 10 meters.
FCC Part 15A above 1 GHz

IMMUNILY oo EN 61326:1997 + A2:2001,
Table 1
EMC/EMI .....coooovviiiiiiiieiieeeee, CE, C-Tick and FCC Part 15

(Class A) Compliant

@ Note For EMC compliance, you must operate this device with shielded cabling.
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CE Compliance

The SCXI-1383 meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety) ............. 73/23/EEC

Electromagnetic .......cc.cceeevenveveneencnne. 89/336/EEC
Compatibility Directive (EMC)

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, click Declarations
of Conformity Information at ni.com/hardref.nsf/.
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